
3 RAD SA PROSTORNIM I TEMATSKIM PODACIMA 

ADMINISTRATIVNIH JEDINICA - OPŠTINA 

3.1 Tekst zadatka 

Kreirati novi QGIS projekat i u njega učitati obezbeđene geoprostorne podatke administrativnih 

jedinica (AJ) u Srbiji u vidu poligona. Ovi podaci dati su u 7. zoni državne Gaus-Krigerove 

projekcije. Za svaku AJ treba prikazati njenu oznaku sa nazivom opštine. Izvršiti uvoz tabelarnih 

podataka o površinama katastarskih kultura po opštinama i povezati ih sa poligonima. Na osnovu 

podataka vrednosti atributa po tabelama izvršiti postavljanje različitih upita nad podacima. Na 

osnovu dobijenih podataka izvršiti određenu stilizaciju grafičkog prikaza, formirati kartu ovog 

područja i kreirati izveštaje iz baze na osnovu postavljenih upita. 

3.2 Podaci neophodni za izradu zadatka 

Podaci neophodni za izradu zadatka dati su u samoj vežbi na sajtu egeo.grf.bg.ac.rs i to: 

 Vektorski podaci o opštinama - administrativnim jedinicama Republike Srbije dat u 

Gaus-Krigerovoj projekciji 7. zone Državnog koordinatnog sistema u u ESRI Shapefile 

formatu (Opstine.zip). 

 Tabelarni podaci o administrativnim jedinicama i načinu korišćenju površina u CSV 

formatu (KatastarskeKulture.zip). 

http://egeo.grf.bg.ac.rs/mod/folder/view.php?id=155


3.3 Postupak izrade 

Korak 1: Pokretanje QGIS-a 

Pokrenuti QGIS softverski paket dvoklikom na odgovarajuću ikonicu. Ukoliko ikonica nije 

kreirana na radnoj površini računara (engl. Desktop), program se može pokrenuti i sa lokacije 

gde je instaliran. Po podrazumevanim podešavanjima, izvršna datoteka će se nalaziti na putanji 

"C:\Program Files\QGIS 3.16\bin". 

Korak 2: Učitavanje poligona opština 

Podaci o administrativnim jedinicama Republike Srbije predstavljeni su u vidu vektorske 

strukture podataka. Učitavanje vektorskih podataka se vrši opcijom koja se poziva iz 

menija Layer → Add Layer → Add Vector Layer ili klikom na alatku . Nakon toga, u dijalog 

prozoru Add vector layer definiše se tip izvora podataka i putanja do datoteke (Slika 3-1). 

Podešavanja vektorskog izvora (tip izvora i kodiranje) je potrebno ostaviti na podrazumevanim 

podešavanjima ukoliko se vektorski podaci učitavaju iz fajlova i ako su tabelarni – tekstualni 

podaci o tim entitetima upisivani latinicom. 

Ukoliko su tabelarni podaci pisani ćirilicom. Tada je potrebno u sekciji Encoding odabrati 

Windows 1251, ISO-8859-5 ili KOI8-F. Ovo je moguće uraditi i naknadno, kad su već učitani 

podaci, tako što će se otvoriti meni Properties desnim klikom nad tim slojem i u kartici General 

za Data Source Encoding odaberu navedeni formati. 

Putanja do datoteke se definiše klikom na dugme Browse, i odabirom vektorskog fajla sa 

ekstenzijom .SHP. Potrebno je pronaći ESRI Shapefile sa poligonima administrativnih jedinica 

Republike Srbije, i klikom na dugme Open završiti učitavanje (Slika 3-1). 



 

Slika 3-1. Prozor za učitavanje vektorskih slojeva 

U ovom prozoru je moguće odabrati i učitavanje podataka iz baze podataka ili iz direktorijuma 

sa skupom vektorskih podataka. Učitavanje je moguće izvršiti i direktnim prevlačenjem 

pomenutog fajla u radno okruženje QGIS-a. 

U narednom koraku neophodno je dodeliti projekciju učitanim poligonima. Ovo se vrši tako što 

se u dijalog prozoru Coordinate Reference System Selector odabere neka od već predefinisanih 

podešavanja za koordinatni sistem odn. MGI 1901 7 Zone (USER:6316). Ukoliko se ovaj dijalog 

ne prikaže automatski prilikom uvoza podataka, moguće ga je otvoriti desnim klikom na sloj i 

odabirom opcije Set Layer CRS. 

Pretraga postojećih koordinatnih referentnih sistema je olakšana definisanjem filtera pretrage na 

osnovu imena ili ključne reči (u delu filter se upiše 6316). Softver će automatski uzastopno 

pokrenuti pomenuti dijalog za dodelu projekcije prostornim podacima ukoliko se više datoteka 

učitava odjednom. 

Korak 3: Prikaz oznaka opština na karti 

Vektorski sloj opština sadrži atribute za svaki poligon kao što su Matični broj opštine, Matični 

broj grada, Ime Opštine itd. Da bi se u prikaz uključili nazivi opština, neophodno je u dijalog 



prozoru Layer Properties odabrati karticu Labels, a potom iz padajućeg menija odabrati Show 

labels for this layer. Label with padajući meni definiše željeni atribut koji će biti prikazan za 

svaki vektorski entitet, u konkretnom slučaju atribut „ImeoLatV“ (Slika 3-2). U istom dijalog 

prozoru može se podešavati veličina oznake (Label), font, stil, boja, transparentnost itd. 

 

Slika 3-2. Prozor za stilizaciju oznaka sloja 

Korak 5: Učitavanje dodatnih opisnih - tabelarnih podataka o načinu korišćenja 

zemljišta unutar opština 

Da bi se učitali tabelarni podaci koje je potrebno povezati sa postojećim entitetima slojeva u 

QGIS-u, potrebno je iste pripremiti u vidu CSV (Comma Separated Values) fajlova. Na taj način 

se navedeni tekstualni fajlovi mogu uvesti u QGIS definisanjem separatora između unetih 

vrednosti čime se podaci razvrstavaju na pojedinačne atribute. Potrebno je tabelu otvoriti i u MS 

Office Excel-u ili drugom editoru tabela (LibreOffice ili OpenOffice) i sačuvati kao CSV fajl 

(File-Save As i kao Save as type: odabrati CSV MS-DOS (*.csv) ili Comma delimited). Ovde 

nastaje problem kod MS Excel-a ukoliko je tekst pisan ćiriličnim ili latiničnim slovima jer će 

doći do gubljenja odn. konverzije nekih karaktera (č, ć, ž, š i drugi) u znak pitanja „?“ (navedeni 

CSV format je predviđen za ANSII karaktere a ne i za Unicode). Drugi problem koji treba da se 

reši jeste skraćivanje naziva atributa jer DBF fajlovi kao sastavni fajlovi ESRI Shapefile ne 

podržavaju nazive atributa/kolona veće od 10 karaktera. Ovo se može prevazići pisanjem Alias-a 

odn. punih naziva atributa u okviru kartice Fields opcije Properties pomenutog sloja. 

Za potrebe ove vežbe podaci o zastupljenim katastarskim kulturama u opštinama su pripremljeni 

u vidu normalizovanih tabela sa podacima o ukupnoj površini zastupljene kulture kao i 

procentualnom udelu iste u opštini. 

Navedeni tekstualni fajlovi se učitavaju pozivanjem komande Layer – Add Layer – Add 

Delimited Text Layer… sa podešavanjima kao na Slika 3-3. Ovde je potrebno voditi računa o 



kodiranju tekstualnih podataka (Encoding) za koje treba odabrati UTF-8 ako se uvoze latinična 

slova. 

 

Slika 3-3. Učitavanje tekstualnog sloja u vidu tabele 

Korak 6: Pridruživanje tabelarnih podataka o načinu korišćenja zemljišta poligonima 

opština 

Nakon učitane tabele potrebno je izvršiti pridruživanje tabele entitetima poligona opština preko 

jedinstvenog atributa – primarnog ključa tabele. Ovo se pokreće desnim klikom na sloj 

geometrija poligona opština i odabirom opcije Properties . U okviru ovog prozora postoji kartica 

Joins gde je potrebno kliknuti na dugme  da bi se definisalo novo pridruživanje. Za sloj 

opština i pomenutu tabelu koju treba pridružiti najbolje je vršiti pridruživanje preko atributa 

MatičniBrojOpštine (Slika 3-4). Završiti pridruživanjem dva puta klikom na dugme OK. 



 

Slika 3-4. Pridruživanje tabela na osnovu zajedničkih atributa 

Na ovaj način se samo virtuelno povezuju vrednosti atributa iz dodatne tabele te stoga ovi 

pridruženi atributi neće biti vidljivi u nekim drugim funkcijama QGIS-a. Zato je najbolje izvršiti 

čuvanje pridruženog sloja u novom fajlu pri čemu treba voditi računa o formatu jer neki 

ograničavaju veličinu naziva atributa (ESRI Shapefile na 10 karaktera) dok su drugi samo za 

transfer a ne i za editovanje (MapInfo MIF file i CSV). Za sada je najbolje vektorske podatke 

čuvati u GeoPackage bazi podataka unutar koje može da se čuva više slojeva različitih tipova 

geometrija (tačka, linija, poligon) i koja nema ograničenja što se tiče dužina naziva atributa – 

kolona tabele. Potrebno je kliknuti desnim klikom na pomenuti sloj pa na komandu Save as i 

onda obabrati tip podatka GeoPackage. Ukoliko se automatski ne učita vektorski sloj u radni 

prostor QGIS-a, potrebno je ponoviti postupak dodavanja sloja GeoPackage povezivanjem na 

kreiranu geoprostornu bazu podataka. 

Nakon povezivanja vektorskog sloja sa tabelarnim podacima otvoriti tabelu atributa 

novokreiranog sloja i proveriti da li ispravno pridruženi podaci (Slika 3-5). 



 

Slika 3-5. Provera pridruživanja podataka 

Korak 7: Stilizacija poligona opština na osnovu katastarskih kultura 

Stilizaciju poligona je moguće uraditi na osnovu određenih klasa atributa kao u prethodnim 

vežbama, ali takođe moguće je definisati i gradacijski paletu boja na osnovu količine izražene 

preko nekog atributa (npr. ukupne površine određene kulture po opštinama). Gradacijski prikaz 

obojenosti poligona na osnovu ukupne površine opštine prikazan je u opciji Properties sloja 

Opštine (Slika 3-6). Na isti način se može definisati obojenost za druge atribute. 

 

Slika 3-6. Prozor za stilizaciju sloja poligona opština 

Korak 8: Definisanje selekcije entiteta i vršenje upita na osnovu kombinacije atributa 

U zavisnosti od tražene vrednosti atributa moguće je selektovati pojedine poligone opština i 

izvršiti njihovo naglašavanje radi kasnijeg prikaza na karti. Ovo se vrši pokretanjem komande 

Select features using an expression i unošenjem odgovarajućeg kôda za vršenje selekcije entiteta 

na osnovu određenih vrednosti atributa kao i njihovih kombinacija. Primeri ovakve definicije 



mogu se naći u vežbi Rad sa vektorskim podacima u priloženom Praktikumu iz 

geoinformatike. Na primer, moguće je selektovati opštine koje imaju njive na površini većoj od 

50% ukupne površine opštine korišćenjem sledećeg upita u dijalogu Select features by using an 

expression:  

"Administrativne jedinice-kulture_NjivaPovrsProcenat" >'50' 

Ovde je potrebno znati da je naziv polja sastavljen od naziva tabele koja se pridružuje i atributa 

koji se nalazi u njoj. Ceo naziv se stavlja pod navodnike jer je naziv atributa a vrednost atributa 

se stavlja unutar apostrofa (’’) samo ukoliko je u formatu teksta - stringa. Izvršavanjem ovog 

upita svi poligoni koji zadovoljavaju ovaj uslov biće obojeni žutom bojom (Slika 3-7). 

 

Slika 3-7. Selekcija opština koje imaju površinu pod njivama veću od 50% 

Takođe je moguće zadati svim ovim poligonima određenu šrafuru ili drugačiju boju unosom 

ovog kôda u deo za stilizaciju sloja definisanjem pravila (Slika 3-8Slika 3-8) kao što je to već 

urađeno u prethodnim vežbama. 

http://egeo.grf.bg.ac.rs/pluginfile.php/271/mod_resource/content/1/4.%20RAD%20S%20VEKTORSKIM%20PODACIMA.pdf


 

Slika 3-8. Definisanje filtera/pravila za bojenje poligona u crveno na osnovu upita 

Ukoliko je potrebno selektovati opštine koje imaju njive na površini većoj od 50% ukupne 

površine i na kojima su zastupljenim ribnjaci većim od 2 ha, tada je potrebno ili prvo izvršiti već 

primenjenu selekciju pa primeniti opciju selekcije Select within selection (Slika 3-9), ili samo 

uneti sledeći kôd: 

"Administrativne jedinice-kulture_NjivaPovrsProcenat" >'50' AND "Administrativne jedinice-
kulture_RibnjakPovrsinaHa" >'2' 

gde se vrši presek navedenih selekcija sa operatorom AND. Na isti način se mogu sabirati 

selekcije (Add to selection ili OR) ili oduzimati selekcija iz već selektovanih entiteta (Remove 

from selection ili XOR). 

Nakon izvršene selekcije unutar tabele atributa moguće je pozicionirati selekciju (plavo 

označene redove tabele) na vrh tabele tako što će se pritisnuti ikonica Move selection to top . 



 

Slika 3-9. Selekcija nad već postojećom selekcijom  

Ukoliko se želi pronaći opština sa najvećom površinom katastarske kulture Voćnjak moguće je 

izvršiti sortranje tabele atributa po ovom atributu klikom na zaglavlje tog atributa ili za proračun 

bio kakve statistike nad numeričkim atributima tabele moguće je koristiti plugin GroupStats. 

Korak 9: Instalacija plugin-a za potrebe proračuna statistike podataka iz tabele atributa 

Veliki broj algoritama za analize i procesiranje prostornih podataka inkorporirani su u vidu 

dodataka (engl. plugin) koji se preuzimaju sa zvanične veb-stranice plugin-ova za QGIS ili nekih 

drugih dostupnih izvora. Konkretno, za ovu vežbu je potrebno instalirati plugin GroupStats. 

Potrebno je pokrenuti komandu Plugins → Manage and install plugins. U dijalog prozoru 

pretražiti plugin-ove u polju Search radi pronalaženja plugin-a GroupStats. Označiti ga i 

instalirati na dugme Install plugin u donjem desnom uglu dijaloga. Posle toga, plugin GroupStats 

treba da se nalazi u grupi Installed. Obavezno čekirati kvadratić prikazan ispred naziva plugin-a 

kako bi bio aktivan u radnom okruženju QGIS-a (Slika 3-10). 

http://plugins.qgis.org/plugins/


 

Slika 3-10. Instalacija plugin-a Group Stats 

Pre pokretanja plugin-a GroupStats, potrebno je pokrenuti komandu Select features using an 

expression. Ukoliko je neophodno, izvršiti selekciju entiteta tako da budu prikazane samo 

poligoni Opština koje pripadaju traženoj selekciji. Group Stats se pokreće preko menija Vector 

→ Group Stats → Group Stats. Navedeni pugin ne radi nad tekstualnim vrednostima 

(decimalnim vrednostima atributa) tako da je potrebno te atribute prevesti u cele brojeve 

pozivanjem Field Calculator-a i generisanjem novog atributa (Slika 3-11). 



 

Slika 3-11. Kreiranje novog atributa celobrojnog formata 

U dijalogu ovog plugin-a izabrati odgovarajući sloj Opstine. Potrebno je u polju Columns iz 

spiska funkcija prevući funkciju Max a u polju Value izabrati atribut po kome se izvršava 

funkcija za računanje statističkog parametra (kolona  NjivaPovrsinaHa). Izbor se vrši tako što se 

selektuje naziv kolone ili funkcije i prevuče na odgovarajuće polje (Columns, Rows ili Value) i 

otpusti levi taster miša. Obavezno označiti Use only selected features, kako bi se upit izvršio 

samo nad traženom selekcijom, tj. selektovanim poligonima opština unutar ovog sloja. 



 

Slika 3-12. Određivanje najveće površine opštine pod njivama korišćenjem plugin-a GroupStats 

Klikom na opciju Calculate dobija se traženi rezultat opštine sa najvećom površinom parcele 

katastarske kulture Njiva (Slika 3-12). Ovde je samo nezgodno što se samo prikazuje vrednost 

tog polja a ne i drugi atributi vezani za taj entitet (koja je opština i dr.). Za dobijanje ovih 

informacija potrebno je vršiti kombinacije sa unošenjem atributa u polja Rows i Columns ovog 

plugin-a. 

Takođe je moguće vršiti prebrojavanje entiteta koji zadovoljavaju određeni uslov (Count) i 

drugih statistika (Min, Mean i dr.). 

Napomena: Ukoliko upit nad zadatom selekcijom ne daje tražene rezultate ili izbacuje No data u 

statusnoj liniji na dnu, potrebno je probati selektovanje podataka preko opcije Filter u Group 

Stats i unosa istog upita u taj prozor kao i za iznad korišćenu komandu za selekciju Select 

features using an expression. Tada je najbolje čekirati i opciju Use only selected features jer će 

se ovako filtrirati podaci iz cele tabele. 

http://egeo.grf.bg.ac.rs/mod/resource/view.php?id=68

